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TS-Quick-Start

TS Cameras ship from Fastec with:

1.	 CAT 6 Ethernet cable (6’)
2.	 12v Power Supply with Lemo camera connector
3.	 USB Flash Drive with Software and Manuals
4.	 16GB SDHC SD card
5.	 Lemo to 3 x BNC I/O cable (Trigger-in, Sync-in, Sync-

out)
6.	 C-mount body cap
7.	 3/32 Allen wrench for C-mount back-focus adjustment

Equipment

Need additional help?
Email: Support@fastecimaging.com
Register for Tutorials, Tools, Updates, etc.

IL Options and Accessories:

1.	 F-mount or PL-mount (mounted on camera) If present, 
C-mount, adjustment shims and, 5/32 wrench will be 
included.

2.	 WiFi USB adapter
3.	 Lemo to 6 x BNC I/O cable (Trigger-in, Trigger-out, Sync-

in, Sync-out, Arm-in, Arm-out)
4.	 Battery charger + extra battery
5.	 External battery clip or belt
6.	 Trigger Switch
7.	 Additional 16GB or 32GB SDHC SD card
8.	 Lenses 
9.	 Tripod and/or Magic arm
10.	 Lights and light stands

Control PC Requirements:

1.	 Windows PC (running Win7, 8, or 10), or Mac PC (Mountain Lion or higher)
2.	 6 GB of memory for 1-camera systems, 2GB additional memory recommended for each additional 

camera 
3.	 Gigabit Ethernet controller. Support for 9K Jumbo packets is recommended. (qualifying 

Thunderbolt-2 and USB-C to Gig-E adapters are available)
4.	 PC storage for image files: SSD recommended

mailto:Support%40fastecimaging.com?subject=IL5%20Setup%20Help
https://www.fastecimaging.com/plans/membership/
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12. USB OTG  (Micro A/B)

13. SDHC (SD-Card slot)

14. GigE Port (RJ45)

15. Sync I/O, Trigger (Lemo)*

16. HDMI Port (Type A)

17. DC Power In (Lemo)**

*Warning: LVTTL 3.3v max 
**10vdc to 26vdc

Camera LEDs, Buttons, I/O
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1. Power LED

2. Network activity 
LED

3. Storage activity LED

4. Camera status LED

5. Sync activity LED

6. Battery status LED

7. Power ON/OFF 
button

8. Arm button

9. Display button

10. Menu button

11. D-Pad 
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31. Camera strap attachment

2. USB port door

3. Power button

4. Trigger button

5. Top mount 1/4-20
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6. 1/4-20 Tripod mount

7. Hand strap attachment point

8. Battery door
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Charging

Power On

•	 Turn the camera on by pressing the Power 
button.  The camera will also power up 
whenever the battery is installed or when 
external power is applied.

•	 If external power is applied and the battery 
is installed at power up, the battery charge 
dialog will appear on the screen. By default, 
the camera will begin charging the battery if it 
is not already fully charged. 

•	 From the charging dialog, the user must select 
“Camera On” to boot the camera. Dual Mode 
models offer a choice of SSD speed. Choose 
“Fast SSD” only if the camera will be operated 
with external power.

•	 The camera battery does not 
charge while the camera is 
in use. 

•	 With the camera powered 
on and attached to the DC 
power adapter, press the 
Power Button once to open 
the Charging dialog. 

•	 While the camera is 
charging the Battery LED 
will blink. When the battery 
is completely charged the 
camera will fully power down. 
This may take up to 5 hours.

Power Off
•	 The camera may be powered off from the Charging Menu by clicking on the Power Off button.
•	 The camera may also be powered down from external software--FasMotion or the Web-Application
•	 “Panic” power down may be done by pressing and holding the power on/off button for a few 

seconds.
Note: If the camera powers down because of panic power down, or it runs out of battery power, there 
may be negative consequences:
1.	 Any setup changes may be lost
2.	 Any recording in memory is lost
3.	 The file system on any internal storage device may become corrupted--including the SSD 
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Controls and Buttons
•	 On/Off button powers the camera on and 

off. If the battery is installed and the power 
adapter is attached,  the battery charging 
dialog will appear (see the section on 
Power). 

•	 Trigger button function is dependent on 
the camera state and recording mode. If the 
camera is not armed (in any mode) pressing 
the Trigger will capture one still image. In 
Basic mode the Trigger will initiate a record 
cycle on an Armed camera, which will end 
with the camera saving or playing back 
the recording. On Dual Mode cameras (“D” 
option), in Long Record ROC mode, the 
Trigger will toggle the camera between 
Recording and Armed. In Long Record BROC 
mode, the Trigger will capture a specified 
number of frames then return to Armed. 

•	 DISP button toggles the Display through several 
modes: Display on, Display on with Histogram, 
and Display off. When reviewing clips, it also turns 
playback controls and per frame metadata on and off. 

•	 Menu button toggles the on screen menus on and 
off. While navigating menus, the Menu Button is used 
to go backward through levels of the menu.  (When 
touch-enabled the icon in the upper left of the screen 
has the same function.)

•	 Directional Pad (D-Pad) for navigating and selecting 
items on the camera menu.

•	 Arm button begins or cancels recording. 
•	 Touch Control. With touch enabled you can navigate 

through the menus and dialog boxes simply by 
touching the display. If Touch is not enabled, navigate 
to the System menu and down to “Touchscreen” using 
the D-Pad. Click on the “Disabled” button. The display 
will go blank except for a small icon in the upper left 
corner. Touch that icon to display the menus.

On/Off       Trigger
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Record Setup
1.	 In the Record Menu Select Mode Setup. 

The choices available will depend on the 
camera model. The Dual Mode cameras 
will have both Standard and Long Record 
options available. (Dual Mode cameras will 
reboot when going back and forth from 
Standard to Long Record.)

2.	 Select the desired options using the Mode 
Options dialog. These will vary depending 
on the selected mode:

•	 In Standard modes and Long Record 
Basic, one of the settings is Trigger 
Position. Setting the trigger point divides 
the internal memory into two sections: 1) 
a circular buffer reserved for pre-trigger 
frames; 2) a second buffer for post-trigger frames. The images recorded before the trigger 
are given negative frame numbers (oldest is most negative, the newest is -1), the image taken 
at the time of the trigger is “frame 0,” and all frames taken after the trigger are given positive 
numbers. 

W
Note that with an “End” trigger, all 
frames will have negative numbers 
except for frame 0, which will be 
the last frame. With a “Start Trigger” 
the recording will begin at frame “0” 
and all subsequent frames will have 
positive numbers. 
•	 LR FasCorder modes (ROC and 

BROC) the trigger position is 
always “Start.”

3.	 Select Settings to change Frame 
Rate or Resolution.

4.	 Set the Shutter Speed using the 
presets or select Advanced on 
the Shutter Speed menu to use 
the Exposure Setting Slider.

5.     Press the Arm Button to begin 
recording. 

Note that while a recording is in progress it will 
not be possible to change resolution or frame 
rate. It is possible, however, to change the shut-
ter speed in order to accommodate changes in 
lighting.
6.	 Trigger the camera via the Trigger Button 

or a Trigger Signal to the Sync I/O port to 
initiate the record cycle. If you are using Standard Basic or Long Record Basic, the camera will 
enter Playback when the recording is finished. If you are using FasFire or Autosave, the camera 
will save the recording to storage media and re-Arm. If you are using LR FasCorder ROC mode, 
the camera will toggle between Armed and Recording each time you trigger. If you are using LR 
FasCorder BROC mode, the camera will record a specified number of frames with each trigger, 
then return to the Armed state.
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Playback

Use the playback icons to play forward, backward, or jump to points of interest in the movie. Use the 
Cut In and Cut Out icons to select a portion of the movie to review or save.

Skip Back Pause Skip FwdCut In Cut Out Save

Beginning Play Bkwd Play End TriggerLive

Event Markers, such as “Record Start” may 
be enabled from the Review menu. When 
markers are present, the Beginning and End 
playback icons change to Skip to Next and 
Previous Marker. This is particularly handy 
when using the LR ROC or BROC feature:
1.	 Select Events in the Review Menu.
2.	 Select the Enable markers check box.
3.	 Click on the Record Start button and change the value to “1.”
4.	 Click on “OK.”

Previous Marker Next Marker

Delete

1.	 Select the Save Icon from the playback controls. This will 
bring up a dialog that allows selection of the following:
•	 Start and Stop points of the clip (these points can also 

be changed using Cut In/Out buttons on the playback 
controls).

•	 Destination—where the movie clip is to be saved. 
Choices include the built-in SSD, (an option), an SD card 
or a USB drive.

•	 The file Format desired—Partition Capture (CAP), AVI, 
BMP Stack, JPEG Stack or TIFF Stack. (CAP files may 
only be saved to an SSD. They are raw, uncompressed 
images. CAP files are the only format that may be re-
loaded and played back on the camera.) 

•	 File name prefix, which may optionally include the 
camera name or user-defined tag..

•	 Use the default file name tag or change it.
•	 Write a comment that will be displayed in the metadata 

for the clip.
•	 Save XML Metadata. Select this if you would like an XML 

containing setup information, timestamps, and marker 
data.

2.	 When the movie clip is set up as desired, press the Save 
button. 

Note: Autosave and FasFire are automatically disabled if 
recording is canceled.
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Save Images to a Host PC

Contact Us!
We want your experience with FASTEC cameras to be as pleasant and productive as 
possible!

We are also very interested to know how your camera is working for you and if there is 
anything we can do to improve  your results, whether that is helping you find the best 
lens, or helping with camera setup. 

Do not hesitate to reach out to us:

Fastec Imaging Corporation
17150 Via Del Campo, Ste. 301, San Diego, CA 92127
+1-858-592-2342

 support@fastecimaging.com

•	 Load FasMotion software on a computer (PC or MAC) and transfer image data via a Gig-E cable to PC. This is 
the fastest method of operation and is highly recommended. 

•	 (Or) Download images from the image memory to any on-board storage (SD card, USB, or SSD). Then, in 
the case of the SD card or USB drive, you may physically move those devices and connect them directly to 
the  PC, or, for any on-board mass storage: connect the OTG cable from the camera’s micro USB connector 
to a PC. While connected, the camera’s on-board storage devices will now act as though they are directly 
connected to the PC. Camera functions are not available while the camera is connected via OTG cable.

Saving captured video in FasMotion:
The Save Video dialog box opens by selecting “Save Video File...” 
from the File menu or the image window context menu, or by simply 
typing Ctrl+S. 

1.	 Set the target location from the radio buttons to “Path” then 
browse to a download destination.

2.	 Adjust start and end frames (this can also be done using the 
bumpers in the playback controls).

3.	 Select the “Save Type”--this may be AVI, DNG, BMP, JPEG, TIFF, 
Click on “Save” to begin the transfer.

Some Save options depend on file types chosen:
•	 If an AVI file is saved to the computer (Path), the Image format 

choices are JPG (compressed MJPEG images) or BMP (un-
compressed bitmaps). 

•	 If a JPG Stack or and AVI/JPG is saved, the JPEG Quality slider 
becomes active, allowing adjustment of the compression/
quality.

•	 If a TIF Stack is saved, the Raw (unprocessed) check box 
becomes active. Note that the TIF(raw) format is a mono (not 
colorized) image. 

•	 TIF-Raw, DNG, and CAP files are the only file types not subject 
to processing on the camera. They are also the only file types in which the full bit depth is 
maintained. (All other file types are saved in 8 bits.)


